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MotionBuilder Installation

Welcome to the Autodesk MotionBuilder 2011® for Microsoft® Windows® software product.
This chapter provides all the information required to install the MotionBuilder software
product as well as all the procedures required to perform prior installing the software product.

For last minute updates to the Autodesk MotionBuilder 2011 software product and
documentation, refer to the Autodesk MotionBuilder 2011 Release Notes posted to the Autodesk
MotionBuilder Product Documentation page at:
http://www.autodesk.com/motionbuilder2011-documentation. You can download (from this web
site) all the latest updates to the MotionBuilder documentation.

NOTE Information in the Autodesk MotionBuilder 2011 Release Notes pertaining to the
installation and licensing of the MotionBuilder software product supersede information
pertaining to the installation and licensing in the Autodesk MotionBuilder 2011 Installation
and Licensing Guide.

Introduction
The steps to install the MotionBuilder software product on a single computer
with a stand-alone license, or on many client computers that will access a
network license from a server machine are similar. The basic workflow to install
MotionBuilder is as follows:

1 Prepare to Install MotionBuilder on page 4

2 Install MotionBuilder on page 6

NOTE If you will use a network license to run MotionBuilder, contact your
network administrator to find your license server name before you start the
installation. If you will use a stand-alone license to run MotionBuilder, see
Activate your Product for information on obtaining your stand-alone license.

1
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Prepare to Install MotionBuilder
Before you install MotionBuilder, ensure you do the following:

■ Verify the system requirements on page 4
See http://www.autodesk.com/motionbuilder-systemrequirements

■ Verify the certified hardware on page 4
See http://www.autodesk.com/motionbuilder-hardware

■ Locate your serial number and product key on page 4
If you have not yet purchased a MotionBuilder license, follow the online
installation instructions.

■ Understand your license type on page 5

■ Close all running programs on page 5

Verify the system requirements
Ensure you have the minimum system requirements for running the 32-bit /
64-bit version of the MotionBuilder software product by going to:
http://www.autodesk.com/motionbuilder-systemrequirements.

Verify the certified hardware
Verify your hardware is certified to run the 32-bit / 64-bit version of the
MotionBuilder software product by going to:
http://www.autodesk.com/motionbuilder-hardware. If you want to purchase
hardware that is certified by Autodesk to optimally run the MotionBuilder
software product, choose from the hardware configurations provided on this
web page.

Locate your serial number and product key
To install MotionBuilder, you need a serial number and a product key. If you
have already purchased a MotionBuilder license, your product serial number
and product key can be found on the outside of the product packaging or in
the Autodesk Upgrade and Licensing Information email you received if you
downloaded your product. Make sure to have these available before you install
the program so that you don't have to stop in the middle of the installation.

4 | Chapter 1   MotionBuilder Installation
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NOTE If you have lost your serial number or product key, contact the Autodesk
Business Center (ABC) at 800-538-6401 for assistance.

The serial number must contain a three-digit prefix followed by an eight-digit
number. The product key consists of five characters.

The information you enter is permanently retained with the product. Because
you can't change this information later without uninstalling, take care when
entering the information. To review this product information later, on the
InfoCenter toolbar, click the drop-down arrow next to the Help button (the
question mark). Then click About - Product Information.

NOTE You may enter your product information at any time during your trial mode
period if you opt to install the product in that mode.

Understand your license type
During the installation process, you need to select which type of license you
will use to run MotionBuilder: a stand-alone license or a network license.

A stand-alone license on page 76 (sometimes referred to as a node-locked license)
is a license for a single computer. The stand-alone license enables you to run
the MotionBuilder product only on the computer where the license is installed.

A network license on page 75 (sometimes referred to as a floating license) is a
license that can be shared by various computers on a network. The
MotionBuilder product is installed on many computers (sometimes referred
to as clients), each with a license file that accesses the network license server.

If you plan to use a stand-alone license to run MotionBuilder, you enter your
serial number during the installation, then register and activate the license
after launching the product. See Activate your product.

If you plan to use a network license, you need to enter the name of your license
server during the installation. Obtain the license server name from your
network administrator before you start the installation process.

If you are setting up a MotionBuilder license server, refer to the Network
Licensing Guide on setting up a MotionBuilder license server.

Close all running programs
The MotionBuilder installation process may stop if some applications such as
Microsoft® Outlook® or virus-checking programs are running. To avoid any
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licensing conflicts when installing MotionBuilder, it is important that you
close all programs and disable virus detection software before launching the
installer.

Install and Run the Product
To use the product, you must install the product, register and activate it, and
then launch it. You must have administrative permissions to install
MotionBuilder.

This section provides instructions for installing and activating MotionBuilder
for an individual user on a stand-alone computer. For information about
installing network-licensed or multi-seat stand-alone versions of the program,
see Network Licensing Guide on page 33.

Install MotionBuilder
The MotionBuilder Installation wizard contains all installation-related material
in one place. From the installation wizard, you can access user documentation,
change the installer language, select a language for your product, install
supplemental tools, and add online support services.

■ Review the installation documentation. It is recommended that you take
the time to familiarize yourself with the complete installation process
before you install MotionBuilder. You can access information on
installation from the installation wizard by selecting the Read this
Documentation option, the Documentation and information links, or through
the Help system.
For late-breaking information, it is also recommended that you review the
product Readme.

To install MotionBuilder using default values on a stand-alone computer:

1 Do one of the following to start the MotionBuilder Installation wizard:

■ If you are installing MotionBuilder from a DVD, insert the DVD into
your DVD-ROM drive.
If the installation process does not start automatically, double-click
the autorun.exe file on your DVD drive.

■ If you are installing MotionBuilder from a download package,
double-click the Autodesk_MotionBuilder_2011_English_Win_32-64bit.exe
file you downloaded.
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2 On the initial page, click Install Products.

3 On the Select the Products to Install page, select your product(s). Click
Next.

4 Review the Autodesk software license agreement. Click I Accept, and then
click Next.

5 On the User and Product Information page, enter your user information,
serial number, and product key. Click Next.

WARNING After you click Next, you cannot change the information entered
on this page unless you uninstall the product.

6 On the Begin Installation page, click Install. In the configuration warning
message, click Yes.

7 On the Installation Complete page, you can view the installation log and
the MotionBuilder Readme.

8 Click Finish.

You have successfully installed MotionBuilder. You are now ready to register
your product and start using the program. To register the product, start
MotionBuilder and follow the on-screen instructions.
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To install MotionBuilder using Custom settings on a stand-alone computer:

1 Do one of the following to start the MotionBuilder Installation wizard:

■ If you are installing MotionBuilder from a DVD, insert the DVD into
your DVD-ROM drive.

■ If you are installing MotionBuilder from a download package,
double-click the Autodesk_MotionBuilder_2011_English_Win_32-64bit.exe
file you downloaded.

2 On the initial page, click Install Products.

3 On the Select the Products to Install page, select your product(s). Click
Next.

4 Review the Autodesk software license agreement. Click I Accept, and then
click Next.

5 On the User and Product Information page, enter your user information,
serial number, and product key. Click Next.

WARNING After you click Next, you cannot change the information entered
on this page unless you uninstall the product.

6 On the Begin Installation page, click Configure.

A window appears with tabs for each component you selected to install.
Each tab gives you a wizard for configuring additional installation options.
Select the tab for any component you want to change, then follow the
instructions to complete the configuration.

7 On the Select the License Type page, select the license type (Stand-alone
or Network). You can also elect to change the default product installation
path.

NOTE If you select the Network license type, enter your license server name
in the field that appears. Contact your network administrator to find the
name of your license server.

8 Click another product tab to configure another product, or click Next
and then Configuration Complete to return to the Begin Installation
page. Click Install.

NOTE To retain a copy of your configuration settings, click Copy to Clipboard.
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9 On the Installation Complete page, you can view the installation log or
the MotionBuilder Readme.

10 Click Finish.

You have successfully installed MotionBuilder. You are now ready to register
your product and start using the program. To register the product, start
MotionBuilder and follow the on-screen instructions.

See also Register and Activate MotionBuilder on page 9.

Install multiple or bundled products
Some Autodesk packages are comprised of multiple products or are part of
multi-product bundles.

In the installation wizard, for packages containing multiple products, you can
choose which products and languages you want to install. During the install
process, you are informed whether a copy of the software is already installed.
You are also warned if your system does not meet the minimum system
requirements for the product. Each product name is displayed on its own
tabbed panel; you can configure them individually.

If you purchased a package that is a multi-product bundle, such as an
educational or institutional package, you may have a package that includes
several Autodesk products. For these bundled packages, an Installer disc
contains information for all the products in the package. The Installer disc
helps you install all of the products.

Register and Activate MotionBuilder
The first time you start MotionBuilder, the Product License Activation wizard
is displayed. You can either activate MotionBuilder at that time, or Try
MotionBuilder and activate it later. Until you register and enter a valid
activation code for MotionBuilder, you are operating the program in trial mode
and the Product License Activation wizard is displayed for 30 days from the
first time that you run the program.

If after 30 days of running MotionBuilder in trial mode you have not registered
and provided a valid activation code, your only option is to register and
activate MotionBuilder. You will not be able to run in trial mode after the 30
days expires. Once you register and activate MotionBuilder, the Product License
Activation wizard is no longer displayed.
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The fastest and most reliable way to register and activate your product is by
using the Internet. Simply enter your registration information and send it to
Autodesk over the Internet. Once you submit your information, registration
and activation occur quickly.

To register and activate MotionBuilder

1 Click the Start menu  ➤  Programs or All Programs ➤  Autodesk  ➤ 

<MotionBuilder>  ➤  <MotionBuilder>.

2 In the MotionBuilder Product License Activation wizard, select Activate,
and then click Next.

This starts the activation process.

3 Click Register and Activate (Get an Activation Code).

4 Click Next and follow the on-screen instructions.

If you do not have Internet access, or if you want to use another method
of registration, you can register and activate MotionBuilder in one of the
following ways:

Email Create an email message with your registration information and
send it to Autodesk.

Fax or Post/Mail Enter your registration information, and fax or mail
the information to Autodesk.

Launch MotionBuilder
Assuming that you followed all of the previous steps outlined in this
installation section, you can launch MotionBuilder and start taking advantage
of its new and updated features. For more detailed information about the new
features, learning videos, online Help, or MotionBuilder services and support,
see the Welcome screen after you launch the product.

You can start MotionBuilder in the following ways:

■ Desktop shortcut icon. When you install MotionBuilder, an MotionBuilder
shortcut icon is placed on your desktop unless you cleared that option
during installation. Double-click the MotionBuilder shortcut icon to start
the program.

■ Start menu. On the Start menu, click Programs or All Programs  ➤  Autodesk
 ➤  <MotionBuilder>  ➤  <MotionBuilder>.
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■ Location where MotionBuilder is installed.

Uninstall MotionBuilder
When you uninstall MotionBuilder, all components are removed. This means
that even if you've previously added or removed components, or if you've
reinstalled or repaired MotionBuilder, the uninstall removes all MotionBuilder
installation files from your system.

You can uninstall the MotionBuilder software product via the Control Panel.

To uninstall MotionBuilder from a Windows XP® 32-bit / 64-bit system:

1 Go to Start > Settings > Control Panel.

2 On the Control Panel, double-click Add or Remove Programs.

3 On the Add Remove Programs dialog, select MotionBuilder 2011 and
click Change/Remove.

To uninstall MotionBuilder from a Windows 7 and Windows Vista 64-bit
system:

1 Go to Start > Control Panel.

2 From the Control Panel, under Programs, select Uninstall a program.

3 In the Uninstall or change a program, select Autodesk MotionBuilder
2011 and click Uninstall.

Troubleshoot Installation
This section provides solutions to installation issues and answers to commonly
asked questions that may arise while installing your product(s). Additional
troubleshooting information and support is also available at
http://autodesk.com/servicesandsupport

General installation issues
This section outlines common issues and their solutions that may arise while
performing a general install of your product(s).
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How can I check my graphics card driver to see if it needs to be
updated?

It is recommended that you verify and update your graphics card driver to
optimize your program. Use the following procedure to identify your current
graphics card driver.

To identify your graphics card driver

1 On the Start menu (Windows), click Settings  ➤  Control Panel.

2 Click the Display icon to access the Display Properties.

In Vista, click Settings  ➤  Control Panel  ➤  Personalization  ➤  Display
Settings.

3 Open the Settings tab and click the Advanced button.

4 Click the Adapter tab to check the adapter type.

5 Click the Properties button and open the Driver tab to check driver version
and see if newer drivers are available.

TIP Many newer graphic cards offer tabbed pages where you can learn more
precise information about your specific graphic card. If specific tab pages are
present, refer to them instead of the Adapter tab.

What is the difference between a stand-alone license and a
network license?

Stand-alone licensed products are registered and activated to an individual
workstation. While the software can be installed on multiple systems in your
facility, the license only allows one system to be operational. If you need to
run more systems, you need to purchase more stand-alone licensed products,
or consider converting to network licenses.

Network licensed products rely on the Network License Manager to keep track
of software licenses. The software can be installed and run on multiple systems,
up to the maximum number of licenses you’ve purchased. The Network License
Manager “checks out” licenses until they are all in use. No further systems
can run the program until a license is “checked in.” If you need to run more
systems, you can purchase additional licenses for the Network License Manager
to maintain.
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What is the benefit of using a network licensed version of the
software?

Network licensed products are recommended for large production facilities,
classrooms, and lab environments. The main advantage is that you can install
products on more systems than the number of licenses you have purchased
(for example, purchasing 25 licenses but installing on 40 workstations). At
any one time, products will run on the maximum number of systems for
which you have licenses. This means you get a true floating license. If software
needs to be run on more systems, additional licenses can be purchased.

What features get installed during a Typical or Custom
installation?

A typical installation includes all of the following features. If you choose a
Custom installation, you can pick and choose from the following feature list.

DescriptionFeature

Open Reality SDK and Python Scripting Developer’s Help
and Reference Help

Open Reality® SDK and

Python® Scripting Help

SDK sample filesSamples

MotionBuilder Help that includes a description of the new
features and changes to the software, a list of resolved and

MotionBuilder Help

unresolved bugs, tutorials, reference topics, workflow top-
ics.

Essential skills moviesLearning Movies

Utility that allows you to use an Autodesk product on more
than one computer without purchasing an additional li-
cense for each computer.

NOTE The utility will not be installed on unlocked versions
of MotionBuilder.

License Transfer Utility
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How do I access my product documentation?
Learning and documentation material is available on the product media. The
complete Help system is installed during the product installation process.
During the installation process, you can access the Installation and Licensing
Guide, the system requirements, certified hardware by selecting the Read the
Documentation or Documentation links in the installation wizards.

Help files include user-interface help, workflows, tutorials, SDK developer’s
help, SDK and Python scripting reference Help. A Readme containing
late-breaking information on the product is also available from the Installation
Complete page.

Where can I check if service packs are available for my software?
To find out if a patch or Service Pack is available for your product, visit:
http://www.autodesk.com/motionbuilder-support.

Networking issues
This section outlines common issues and their solutions with regards to
performing a network installation or configuring your network license server(s).

Where do I find my server name?
When installing a network licensed product, you must specify the name of
the server that will run the Network License Manager. If you don’t know the
server name, you can quickly find it by opening a Windows command prompt
on the system that will be the Network License Manager. At the prompt, enter
ipconfig /all and note the Host Name entry.

Uninstall and Maintenance Issues
This section outlines common issues and their solutions with regards to adding
and removing features, reinstalling or repairing your installation, and
uninstalling products.
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When adding or removing features, how can I tell what features
get installed by default?

To quickly see what gets installed during a Typical, default installation, click
the Restore Defaults button on the Add/Remove Features page.

Is it possible to change the installation folder when adding or
removing features?

Once your product is installed, you cannot change the installation path from
the Add/Remove Features page. Changing the path while adding features
results in program corruption, so it is not an option.

When should I reinstall the product instead of a repair?
You should reinstall your product if you accidentally delete or alter files that
are required by the program. Missing or altered files adversely affect the
performance of your product and cause error messages when you try to execute
a command or find a file.

If an attempt to repair an installation fails, reinstalling is the next best option.

Do I need my original disc(s) to reinstall my product?
When performing a reinstall of the product, you are prompted to load your
original disc(s). Installation data is cached locally on your drive and that data
is reused when reinstalling.

When I uninstall my software, what files are left on my system?
If you uninstall the product, some files remain on your system such as files
you created or edited (drawings or custom menus).

Your license file also stays on your workstation when you uninstall your
product. If you reinstall on the same workstation, the license information
remains valid and you do not have to reactivate the product.
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Glossary of Installation
Terms

The Glossary describes terms specific to the installation of Autodesk software products.

The Glossary also includes acronyms used in the installation process of Autodesk software
products.

Acronyms
The following is a list of acronyms used in the installation process of Autodesk
software products.

MSI
Microsoft installer that supports a variety of parameters that can be scripted.

MSP
Microsoft patch file (see patch).

Terms
The following is a list and description of terms specific to the installation process
of Autodesk software products.

2
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activate
Part of the Autodesk software registration process, it allows you to run a
product in compliance with the product's end-user license agreement.

Active Directory
A directory service from Microsoft that is part of Windows 2000 and Windows
2003 Server that manages the identities and relationships that make up network
environments.

directory service
A network service that identifies all resources on a network and makes them
accessible to users and applications. Resources include email addresses,
computers, and peripheral devices such as printers. Ideally, the directory
service should make the physical network topology and protocols transparent
so that a user on a network can access any resource without knowing where
or how it is physically connected. Virtually all directory services are based on
the X.500 ITU standard.

FLEXnet

License management technology from Acresso™ Software, Inc.. FLEXnet
provides administrative tools that help to simplify management of network
licenses. FLEXnet can be used to monitor network license status, reset licenses
lost to a system failure, troubleshoot license servers, and update existing license
files.

License Transfer utility
Allows you to use an Autodesk product on more than one computer without
purchasing a separate license for each computer.

multi-seat stand-alone installation
A type of installation where multiple stand-alone seats of the program are
installed using a single serial number.
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network license installation
A type of installation where you install the program to workstations with the
files and registry entries that allow the program to communicate with the
Network License Manager.

partial profile
A profile that contains partial registry information corresponding to a subset
of the options available from the Files tab of the Options dialog box.

patch
A software update to an application.

power user
A user with rights to access and write to the Program Files folder and the
HKEY_Local_Machine folder of the registry.

pull technology
An installation technology that requires user interaction to complete the
installation.

scripting
The process of using scripting languages such as VB Script to facilitate the
deployment of software packages.

service pack
Autodesk terminology for an application patch.
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silent mode
An installation that proceeds without any explicit user input. No dialog boxes
are presented that require interaction from the user.
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Stand-Alone Licensing
Guide

Stand-Alone Licensing
A stand-alone license allows you to run an Autodesk® product on a single
workstation.

Introduction
Stand-alone licensing allows you to use your Autodesk product in trial mode
for a given number of days from the first time you launch the product. The
number of days that a trial mode is active differs between Autodesk products.
You can activate your license at any time before the trial period expires.

When you activate your product, you receive an activation code. If you activate
online, your activation code is automatically retrieved from Autodesk and the
product starts. Activations are also available through email, fax, phone, or the
Autodesk website.

NOTE If you are installing and using an Autodesk product on both operating systems
of a dual-boot operating system, you must obtain a separate activation code for
each operating system.

The license file stays on your workstation when you uninstall your product. If
you reinstall your Autodesk product on the same workstation, the license
information is still valid. You do not have to reactivate the product.

3
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Multi-Seat Stand-Alone License
A multi-seat stand-alone license allows you to install, register, and activate an
Autodesk product on several workstations using a single serial number.
Multi-seat licenses can be purchased through your Authorized Autodesk
Reseller.

The Create Deployment feature in the provided installer simplifies deployment
by creating a server image that you can access to install the software on your
workstation. The software activates automatically when it is started for the
first time and if an Internet connection is available.

NOTE To avoid activation failures, it is recommended that you use the provided
installer to create the deployment server image.

For more information about multi-seat stand-alone install, see your product’s
installation documentation.

Activate Your Product
You can activate your Autodesk product either on startup or while you are
running the product. If you cannot activate online, offline activation is
available.

Manage your Stand-Alone License
This section provides information about advanced stand-alone licensing tasks
such as license types and behaviors, viewing product information, saving your
license file as a text file, updating your serial number, and transferring a license.

Check Product Information
You can view detailed information about your Autodesk product and your
product license (such as the license usage type and the license behavior), and
then save this information as a text file.

License usage types

NOTE All license types are available as stand-alone and network except for the
Student Portfolio license, which is available as stand-alone only.
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Commercial A license for a product that was purchased commercially.

Not for Resale A license for a product that is not sold commercially.

Educational (EDU)/Institution A license designed specifically for educational
institutions.

Student Portfolio A license for students who are using an Autodesk product
as part of their curriculum.

License behaviors
Trial A license that allows individuals to try the product in trial mode for a
specified number of days. The trial period starts the first time you launch your
product. When the trial period expires, the product must be registered and
activated to continue use.

Permanent Allows permanent use of an Autodesk product.

Term Extendable Allows access to an Autodesk product for a limited time.
The term can be extended at any time.

Term Non-Extendable Allows access to an Autodesk product for a limited
time. The term cannot be extended.

View Product Information

To view product information:

1 Launch MotionBuilder.

2 Select Help > About MotionBuilder from the main menu bar.

3 In the About MotionBuilder 2011 window, click Product License
Information.

4 In the Product License Informationdialog box that appears, view details
about your product and the product license.

See Borrow a MotionBuilder license with sub-features.

5 In the Product License Information dialog box, click Close.

Save License Information as a Text File
You can save your product license information as a text file.
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To save license information as a text file:

1 Launch MotionBuilder.

2 Select Help > About MotionBuilder from the main menu bar.

3 In the About MotionBuilder window, click Product License Information.

4 In the Product License Information dialog box, click Save As.

5 In the Save As dialog box, name the file, choose a location where you
want to save the file, and then click Save.

6 In the Product License Information dialog box, click Close.

Update your Serial Number
If you installed your product with the trial serial number (000-00000000), you
can update that trial serial number with a valid serial number. Your valid serial
number is located on the outside of the product packaging or in the Autodesk
Upgrade and Licensing Information email you received if you downloaded your
product.

NOTE If you have lost your serial number, contact the Autodesk Business Center
(ABC) at 800-538-6401 for assistance.

When you register and activate your product, you are asked for the product
serial number, which is automatically entered upon completion of the
activation process.

If you have a multi-product bundle of software that uses a single serial number,
only the first product you register and activate displays the updated serial
number. For other products to display the serial number, you must update it
from the Help menu.

To update your serial number:

1 Launch MotionBuilder.

2 Select Help > About MotionBuilder from the main menu bar.

3 In the About MotionBuilder dialog box that appears, click Product License
Information.

4 In the Product License Information dialog box, click Update.

26 | Chapter 3   Stand-Alone Licensing Guide



5 In the Update the Serial Number dialog box, enter your product serial
number.

The serial number is located on the outside of the product packaging or
in the Autodesk Upgrade and Licensing Information email you received if you
downloaded your product.

NOTE If you have lost your serial number, contact the Autodesk Business
Center (ABC) at 800-538-6401 for assistance.

6 Click OK. You can now see the updated serial number.

Transfer your Stand-Alone License
You can use an Autodesk product on more than one computer without
purchasing a separate license for each computer. License transfers are only
supported on products that require the creation of an Autodesk ID as part of
the registration and activation process.

About the License Transfer Utility
The License Transfer Utility transfers a product license online from one
computer to another, and ensures that the product works only on the computer
that contains the license. The License Transfer Utility is a custom stand-alone
installation option. During installation, a shortcut is created. A shortcut is
installed once per product, per workstation.

You may want to transfer a license to a computer temporarily (if you want to
use an Autodesk product on your laptop, for example) or permanently (if the
computer where you originally activated your Autodesk product is being
replaced). You can leave the license on the secondary computer indefinitely,
or you can move the license between computers as needed.

License transfers rely on the product’s serial number. Before an Autodesk
product can be exported, it must be activated with the serial number and
product key. During license import, a previously activated and exported license
is imported to a product or product suite installed with the same serial number.
The activation is transferred to the import computer, completing the license
transfer.
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NOTE The number of concurrent exports you can have, is equal to the number
of seats you own. For example, if you own one seat you can have one export in
progress at a time. You cannot complete another export until the one in progress
has been imported. Similarly, if you have five seats, you can have up to five
concurrent exports in progress at one time.

NOTE When you upgrade your Autodesk product (non-subscription), you can no
longer perform online license transfers of the previous license.

NOTE Although the License Transfer Utility allows you to transfer your product
license between computers, your license agreement may not allow the installation
of an Autodesk product on more than one computer. Read your license agreement
to find out whether your product license permits the use of the License Transfer
Utility.

To transfer a license you must have an Internet connection, have an Autodesk
product installed on both computers, and perform an online export and import
of the license.

Install the Autodesk Product
Before you can use the License Transfer Utility to transfer licenses, you must
have an Autodesk product installed on all computers involved in the transfer.

To install the Autodesk product

1 Install and activate the Autodesk product on a computer.

See your product's installation instructions for complete details.

2 Install the Autodesk product on any other computer that will be using
the License Transfer Utility. You do not have to register or activate the
product on this computer.

See your product's installation instructions for complete details.

Export a License
A license is exported when the License Transfer Utility moves a product license
from a computer to the online Autodesk server.

The license can be exported as public or private. Exporting a license as public
means that you are not reserving the license and anyone using the same serial
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number and their own user ID and password can import that license. Exporting
a license as private means that you are reserving that license for yourself and
the license can only be imported with the same serial number, your user ID,
and your password.

NOTE An Internet connection is required to export a license.

To export a license:

1 On the computer where you want to export the license, do the following:

■ (Windows XP/Windows 7/Windows Vista) Click Start  ➤  All Programs
 ➤  Autodesk  ➤ [Autodesk Product]  ➤  License Transfer Utility.

The License Transfer Utility displays the Autodesk product name and
serial number.

2 In the License Transfer Utility, click Sign In.

3 On the Log In page, enter your Autodesk user ID and password and click
Log In.

4 On the License Export page, confirm the export information.

5 If you want to make the license available as a public import, click Make
the license available as a public import.

6 Click Export.

7 On the License Export Confirmation page, click Finish.

Import a License
A license is imported when the License Transfer Utility moves a previously
exported product license from the online Autodesk server to a computer.

When you have exported a product license from a computer, you complete
the license transfer process by importing that license onto a computer. A
license is imported when the License Transfer Utility creates an active license
on a computer, allowing your Autodesk product to run on this computer.

When you use the License Transfer Utility to import a license to a computer,
you are not activating the product on the computer; you are simply transferring
your activation to this machine.

NOTE An Internet connection is required to import a license.
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To import a license:

1 On the computer where you want to import the license, do the following:

■ (Windows XP/Windows 7/Windows Vista) Click Start  ➤  All Programs
 ➤  Autodesk  ➤ [Autodesk Product]  ➤  License Transfer Utility.

The License Transfer Utility displays the Autodesk product name and
serial number.

2 In the License Transfer Utility, click Sign In.

3 On the Log In page, enter your Autodesk user ID and password and click
Log In.

4 On the License Import Confirmation page, click Finish.

The license is now imported to the computer and you can run your
Autodesk product on this computer. If you want to transfer the license
to another computer, repeat the export and import procedures.

To import a license to replace a trial license

1 On the computer where you want to import the license, do the following:

■ (Windows XP/Windows 7/Windows Vista) Click Start  ➤  All Programs
 ➤  Autodesk  ➤ [Autodesk Product]  ➤  License Transfer Utility.

The License Transfer Utility displays the Update the Serial Number and
Product Key options.

2 Enter the serial number and product key to update your Autodesk product
and click Update.

The License Transfer Utility displays the updated serial number.

3 In the License Transfer Utility, click Sign In.

4 On the Log In page, enter your Autodesk user ID and password and click
Log In.

5 On the License Import Confirmation page, click Finish.

The license is now imported to the computer and you can run your
Autodesk product on this computer. If you want to transfer the license
to another computer, repeat the export and import procedures.
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Troubleshoot a Stand-Alone License Error
When you activate your Autodesk product, only the computer that you used
to activate the product is licensed to run the product. If you make certain
changes to your computer, your stand-alone license might fail. You will receive
a license error and you will not be able to use your product. This section
discusses ways in which you can troubleshoot a license error.

Some license errors require you to reactivate your product. If you need to
reactivate your product, the Product Activation wizard is displayed when you
try to run the product. To reactivate your product, follow the instructions in
the Product Activation wizard.

The following topics offer more details regarding specific errors.

Hardware Changes
If you replace or reconfigure hardware on the computer where your Autodesk
product license resides, the stand-alone license might fail. You will not be able
to use your product.

To prevent damage to your product license, use the License Transfer Utility
to export your license file. After you make the hardware change, you can
import the license file back. For instructions about using the License Transfer
Utility, see Transfer Your Stand-Alone License.

NOTE If you get a license error when you change your hardware, you may have
to reactivate your license. See Activate Your Product on page 24.

Reinstalling an Operating System
If you reinstall your operating system on the computer where your Autodesk
license resides, the license might fail. You will not be able to use your product.

To resolve a license error in this case, you must reactivate your product. See
Activate Your Product on page 24.

To prevent a license error when you reinstall an operating system

NOTE If using Norton Ghost™  or another image utility, do not include the Master
Boot Record.
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1 Locate one of the following folders and make a backup copy:

■ (Windows XP) C:\Documents And Settings\All Users\Application
Data\FLEXnet

■ (Windows 7/Windows Vista) C:\ProgramData\FLEXnet

2 Reinstall the operating system and reinstall the Autodesk product.

3 Paste the license folder to the same location from which you originally
copied the folder in step 1.

You can now run your Autodesk product.

Changing the System Date and Time
Your product license allows for time changes to the system clock within two
days of the current time. If you set your system clock back more than two
days, the next time you start your product, you will receive a message that
gives you the option of correcting the system clock. If you do not correct the
system clock, you receive a license error.

To prevent a license error due to a change in system date and time

■ Make sure that your computer's system date and time are accurate when
you install and activate your Autodesk product.
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Network Licensing Guide

Network Licensing
A network license allows you to run an Autodesk product on a network. Network
licenses can be purchased through your Authorized Autodesk Reseller.

Setting up network licenses for an Autodesk product requires careful planning
and execution. This section gives you instructions about how to set up a network
licensed environment, and assumes that you are familiar with the terminology
and processes required to set up an Autodesk product to run on a network.

Plan Your Network Licensing
This section contains information that you need to know before you set up a
network license server. The section includes information about supported license
server models, license operation and availability, network license file definitions
and parameters, license file examples, license types and behaviors, and the
license server heartbeat signal.

System Requirements for the Network License Manager
(Windows)

Make sure that your network license server meets the minimum recommended
requirements. See the following tables for hardware and software requirements.

4
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NOTE The Network License Manager supports Ethernet network configurations
only.

Hardware and software requirements for the network license server (Windows)

RequirementHardware/Software

Windows® 7® 32-bitOperating System

Windows 7 64-bit

■ Windows 7 Starter (32-bit)

■ Windows 7 Home Basic (32-bit)

■ Windows 7 Home Premium

■ Windows 7 Professional

■ Windows 7 Ultimate

■ Windows 7 Enterprise

Windows Vista 32-bit SP2 or later
Windows Vista 64-bit SP2 or later

■ Windows Vista Enterprise

■ Windows Vista Business

■ Windows Vista Ultimate

■ Windows Vista Home Premium and Basic (32-bit)

■ Windows Vista Home Premium (64-bit)

Windows XP 32-bit SP2 or later
Windows XP 64-bit SP2 or later

■ Windows XP Home

■ Windows XP Professional

Windows Server 32-bit SP1 or later
Windows Server 64-bit SP1 or later

■ Windows 2008 Server R2

■ Windows 2008 Server

■ Windows 2003 Server R2

■ Windows 2003 Server
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Hardware and software requirements for the network license server (Windows)

RequirementHardware/Software

Intel® Pentium® III or higherComputer/processor

450 Mhz (minimum)

Compatible with existing Ethernet network infrastructureNetwork interface card

NOTE The Network License Manager supports multiple network interface
cards, but at least one must be an Ethernet card.

TCP/IPCommunication protocol

NOTE The Network License Manager uses TCP packet types.

Internet Explorer® 6Browsers

Internet Explorer 7
Internet Explorer 8

11.7.0.0FLEXnet

Virtual Machine Support (Windows)

Virtual OSVirtualizerHardware

Vista 64-bit, Vista 32-bit, Windows XP
32-bit, Windows 7 32-bit (Home

Windows 2008 or Windows
2003R2 servers running on VM-

Intel PC 64

Premium, Professional, Ultimate, andware® ESX3.5 Update 3 (License
Manager Only) Enterprise), Windows 7 64-bit, Win-

dows Server 32-bit, Windows Server
64-bit

Plan Your License Server Configuration
You must decide which license server model to use for managing your Autodesk
product licenses on a server. Autodesk supports the following network license
server models:

■ Single license server model

■ Distributed license server model

■ Redundant license server model
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Single License Server Model
In the single license server model, the Network License Manager is installed
on a single server, so license management and activity is restricted to this
server. A single license file represents the total number of licenses available
on the server.

Advantages of the Single License Server Model

■ Because all license management takes place on a single server, you have
just one point of administration and one point of failure.

■ Of the three license server models, this configuration requires the least
amount of maintenance.

Disadvantage of the Single License Server Model

■ If the single license server fails, the Autodesk product cannot run until the
server is back online.

Distributed License Server Model
In the distributed license server model, licenses are distributed across more
than one server. A unique license file is required for each server. To create a
distributed license server, you must run the Network License Manager on each
server that is part of the distributed server pool.

Advantages of the Distributed License Server Model

■ Servers can be distributed across a wide area network (WAN); they do not
need to exist on the same subnet.

■ If one server in the distributed server pool fails, the licenses on the
remaining servers are still available.

■ If you need to replace a server in the distributed server pool, you do not
need to rebuild the entire pool.

■ Server replacement is easier than in a redundant server pool, where you
must reactivate the entire pool.

Disadvantage of the Distributed License Server Model

■ If a server in the distributed server pool fails, the licenses on that server
are unavailable.
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Redundant License Server Model
In the redundant license server model, you use three servers to authenticate
a single license file. One server acts as the master, while the other two provide
backup if the master server fails. With this configuration, licenses continue
to be monitored and issued as long as at least two servers are still functional.
The license file on all three servers is the same. You must install the Network
License Manager on each server.

In the redundant license server model, all servers must reside on the same
subnet and have consistent network communications. (Slow, erratic, or dial-up
connections are not supported.)

Advantage of the Redundant License Server Model

■ If one of the three servers fails, all licenses that are managed in the server
pool are still available.

Disadvantages of the Redundant License Server Model

■ If more than one server fails, no licenses are available.

■ All three servers must reside on the same subnet and have reliable network
communications. The redundant server pool does not provide network
fault tolerance.

■ If one of the three servers is replaced, the complete redundant server pool
must be rebuilt.

■ If your Autodesk product supports license borrowing and licenses are
borrowed from a redundant license server pool, you must restart the license
server after you stop the Network License Manager.

Learn About Your License
In this section, you learn about license operation and availability, the license
file, license types and behaviors, and the heartbeat signal.

License Operation and Availability
When you start an Autodesk product, the product determines the server from
which it should try to obtain a license. The product then requests a license
through the TCP/IP network protocol to the license server.
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If the number of available licenses has not been exceeded on the license server,
the Network License Manager assigns a license to the workstation. A product
session then starts on the workstation, and the number of available licenses
on the license server is reduced by one.

Likewise, when you exit a product, the Network License Manager frees a license
for another user. If you run multiple sessions of an Autodesk product on an
individual workstation, only one license is used. When the last session is
closed, the license is freed.

The following three processes manage the distribution and availability of
licenses:

■ License manager daemon (lmgrd.exe). Handles the original contact with
the application, and then passes the connection to the vendor daemon.
The lmgrd.exe daemon is used to communicate with the vendor daemon
only; lmgrd.exe does not authenticate or dispense licenses, but rather passes
user requests to the vendor daemon. By using this approach, a single
lmgrd.exe daemon can be used by multiple software vendors to provide
license authentication. The lmgrd.exe daemon starts and restarts the vendor
daemons as needed.

■ Autodesk vendor daemon (adskflex.exe). Tracks the licenses that are checked
out and the workstations that are using them. Each software vendor has
a unique vendor daemon to manage vendor-specific licensing. As its name
implies, the adskflex.exe vendor daemon is specific to Autodesk products.

NOTE If the adskflex.exe vendor daemon terminates for any reason, all users lose
their licenses until lmgrd.exe restarts the vendor daemon or the problem causing
the termination is resolved.

■ License file. A text file that has vendor-specific license information.

You can run only one Autodesk vendor daemon (adskflex.exe) on your license
server. This means that if you plan to serve licenses for multiple Autodesk
products that were purchased individually (not as part of a suite or bundle)
you must combine the license file contents for the products into one license
file.

For example, if you plan to serve MotionBuilder licenses from a machine that
is already serving 3ds Max licenses, you must append the contents of your
MotionBuilder license file to the 3ds max license file. See Example of a License
File for Combined Autodesk Product Versions.
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TIP You can use the following commands to query the status of your license server
and determine how many licenses you have in total, how many are in use, and to
verify that your license server is up and running.

■ (Windows) lmutil lmstat -a -c <license file> (where <license file>

is your license file name)

License Files
The network license file you receive from Autodesk contains licensing
information required for a network installation. You obtain license file data
when you register your Autodesk product.

The license file contains information about network server nodes and vendor
daemons. It also contains an encrypted digital signature that is created when
Autodesk generates the file.

The license file is located in a network location that you specify in the
Deployment wizard. That network location must be accessible to every user
who runs the product from a network installation.

NOTE If you are already running a network license server for a separate Autodesk
product, such as 3ds Max, you must append the contents of your MotionBuilder
license file to the contents of the license file for the other Autodesk product. See
Example of a License File for Combined Autodesk Product Versions.

The following table defines each license file parameter.

Definitions of license file parameters

ExampleDefinitionParameterLine

LABSERVERHost name of the server where the
Network License Manager resides

Host NameSERVER

03D054C0149BEthernet address of the server where
the Network License Manager resides

Host ID

[None]USE_SERVER

adskflex.exeName of the server-side Autodesk
vendor daemon

Vendor DaemonVENDOR
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Definitions of license file parameters

ExampleDefinitionParameterLine

port=2080Network port number reserved and
assigned for use only by Autodesk

Port Number

products running the Autodesk
vendor daemon

SERIES_1Name of feature code groupNamePACKAGE

1.000Internal version number referenceVersion

COMPONENTS=
"526000REVIT_9_OF\

List of feature codes supported in the
package

COMPONENTS

51200ACD_2007_OF\
513001IN-
VBUN_11_OF"

OPTIONS=SUITEOPTIONS

SUPERSEDEReplacement for any existing Incre-
ment line of the same feature code

SUPERSEDE

from any license files on the same li-
cense server that have a date earlier
than the defined Issue Date

SIGN=0 SIGN2=0Encrypted signature used to authen-
ticate the attributes of the license file

SIGN

51200ACD_2007_0FProduct supported by the license fileFeature CodeINCREMENT

permanentAmount of time the licenses are
available

Expiration Date

25Number of licenses supported by the
license file

Number of Licenses

COMMERCIALLicense usage type and license beha-
vior of the product that is supported
by the license file

VENDOR_STRING
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Definitions of license file parameters

ExampleDefinitionParameterLine

BORROW=4320Definition of the license borrowing
period for the licenses defined under
the same increment line.

BORROW

In this example, the maximum peri-
od that licenses can be borrowed is
4320 hours (180 days), unless other-
wise noted (for example, BOR-
ROW=2880 means that licenses can
be borrowed for a maximum of
2880 hours, or 120 days).
License borrowing is disabled when
this parameter is absent in the li-
cense file.

DUP_GROUP=UHDefinition of multiple license re-
quests when the same user and same
host share the same license

DUP_GROUP

15-jul-2006Date that the license file was gener-
ated by Autodesk

ISSUED

123-12345678Serial number of the Autodesk
product

Serial Number

SIGN=6E88EFA8D44CEncrypted signature used to authen-
ticate the attributes of the license file

SIGN

License File Examples
License file examples are provided in this document to help you understand
how the license files work for your particular network setup. Autodesk provides
a standard license file for individual products and a license file with additional
parameters for products that are sold both individually and as part of a product
set.

■ Standard License File. If you purchase one or more individual products
that are not offered as part of a suite of products, you receive a standard
license file.
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■ Standard License File with Additional Parameters. If you purchase Autodesk
products that are included in a product set and are also sold as an individual
product, you receive a standard license file with additional parameters
included in the license file. The additional parameters define the sequence
for license usage so that the individual product license is used before the
license for the product set.

Autodesk license file examples include a license file not specific to a product,
completed license files for single, distributed, and redundant server models,
a combined product version license file, and an example of additional
parameters added to a standard license file.

Example of a License File Not Specific to a Product
Here is an example of the contents of a license file and the parameters
associated with each line:

SERVER ServerName HostID

USE_SERVER

VENDOR adskflex port=portnumber

INCREMENT feature_code Adskflex Version ExpDate NumberofLicenses

\

VENDOR_STRING=UsageType:Behavior BORROW=4320 SUPERSEDE \

DUP_GROUP=DupGrp ISSUED=IssueDate SN=SerialNumber SIGN= \

Example of a License File for a Single or Distributed Server
Here is an example of a completed license file for a single or distributed license
server model:

SERVER XXHP0528 0019bbd68993

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1393 \

E368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84 C3AF \

7D79 BEE1 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D 2D36 \

057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93 E00B D967

\

D821 BD37 BE6D B78A F074 B223 88AA 242C DD0A 1292 D56F 4108 \

62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F 2EB4"
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Example of a License File for a Redundant Server
Here is an example of a completed license file for a redundant license server
model:

SERVER CCN12378042 001cc4874b03 27005

SERVER XXHP0528 0019bbd68993 27005

SERVER CCN12378043 001cc4874b10 27005

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH ISSUED=10-Jan-2008 SN=123-12345678 SIGN="11C4 \

CA79 07FC 7AD0 409A 6E04 6E98 D76C 197C 0416 076C B211 1CDD \

D0AB 698B 16BF 7A0E D4F8 1CFE 2985 644F 64CD CECE 0DDB 5951 \

3262 7C31 13A8 F08F 55B2" SIGN2="19A6 FDA3 2ED5 5301 8675 7B81

\

1B0E 451B 19F1 1A99 C8E9 CBA6 8CB3 6AC3 8B38 1519 13F2 2373 \

82AE 55E5 1A25 4952 4458 F3A2 6F28 D25D 1DC0 E066 209B 0953"

NOTE The redundant server model requires the addition of a port number (the
default is 27005) for each server.

Example of a License File for Combined Autodesk Product
Versions

You can combine a license file for different releases of the same Autodesk
product or for different Autodesk products, and run all products from one
license server. For example, you can combine a license file for AutoCAD 2009
with license files for Autodesk Maya® 2009 and AutoCAD Map.

If your license server distributes licenses for multiple Autodesk products that
were purchased individually (not part of a suite or bundle), you must combine
the network license information from all products into one license file.
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Here is an example of the contents of a combined license file for AutoCAD 2008
and AutoCAD 2009:

SERVER XXHP0528 0019bbd68993

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1393 \

E368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84 C3AF \

7D79 BEE1 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D 2D36 \

057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93 E00B D967 \

D821 BD37 BE6D B78A F074 B223 88AA 242C DD0A 1292 D56F 4108 \

62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F 2EB4"

INCREMENT 54600ACD_2008_0F adskflex 1.000 permanent 3 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1E6E \

4B61 5712 4766 92A0 6782 9EF4 3F47 56A1 1F38 6DE8 C0C7 90AC \

7289 152E 0EA2 CC0D 3F10 577A 0489 CEB6 10D5 FBCC B552 0C9D \

5966 91A6 59F0 2788 FACE" SIGN2="1DDF 3B9D 3392 71D5 AB08 7E05 \

8497 111E 092F 0E54 8DC2 2BED 17C2 2CC1 981B 0EC2 BC15 8F00 \

C79A ABFD 2136 BABA 2EDF E941 EA53 32C6 597F F805 5A8A 599A"

Example of Additional Parameters in a License File
For Autodesk products that are included in a product set and are also sold as
an individual product, licenses are allocated based on a sequence of priorities
defined in the license file. For those products, information similar to the
following example appears in a license file:

SERVER Server1 1a34567c90d2

USE_SERVER

VENDOR adskflex port=2080

INCREMENT 54600ACD_2008_0F adskflex 1.000 permanent 5 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH ISSUED=09-Jan-2007 SN=123-12345678 SIGN="0247 \

45D6 87C4 27A5 7F9E F24A ED3D 61E4 6B3B CC5C AD77 B865 9EA8 \

3D62 0792 0F67 19E7 57E7 FAFA A48B D582 335A EC16 1FE5 B70D \

76AB 6488 61CC DE5E F5B7" SIGN2="09FD 0850 7CF1 F447 9F05 9FA3

\

2A0A 38D6 83FC 1746 F3F5 5A72 6250 E002 DE0B 0E6E F88C AC95 \

136F 87F2 A945 E4C4 A97F 44B5 74EE 83F3 3F3E 1579 B981 8994"
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Package License File Examples
Autodesk offers a package license file option, which allows you use of a set of
products that are packaged and sold together. The package license file contains
a set number of licenses for four different versions of your software. Running
an instance of any one of the versions uses one license in the package. Packaged
license files support prior versioning for subscription users. Package license
files operate under the following guidelines:

■ Package license files come with the current version of the software and
three previous versions of the same product.

■ License files may be combined with license files for different products. For
more information about combining license files, see Example of a Package
License File for Combined Autodesk Product Versions on page 48.

■ Package license files cannot be combined with non-package license files
for product versions contained in the package. For example, you cannot
combine a Autodesk Product 2009 package license file with a regular license
file for Autodesk Product 2008, 2007, or 2006.

■ Both the PACKAGE and INCREMENT sections of the license are required
for licensing to work properly. When you combine license files, be sure to
include both of these sections.

■ License borrowing, option files, and licensing cascading work the same
for package licenses as they do for regular license files.

■ A new license file will supersede an older license file.

The following sections provide package license file examples for single,
distributed, and redundant license servers, and combined Autodesk product
versions.
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Example of a Package License File for a Single or Distributed
Server

Here is an example of a completed license file for a single or distributed license
server model:

SERVER Server1 1a34567c90d2

USE_SERVER

VENDOR adskflex port=2080

PACKAGE SERIES_1 adskflex 1.000 COMPONENTS="54700REVIT_2009_0F \

54600ACD_2009_0F 51300INVBUN_11_0F" OPTIONS=SUITE SUPERSEDE \

ISSUED=09-Jan-2008 SIGN="1707 9EAC CBCB 2405 692E 4A89 \

AA26 30CC 2AC2 D6B3 A61B AB5E 492E 3EBD 0B48 4E75 193A DA82" \

FC45 C009 E360 944A 14BA E99C 9B24 5A1B 4A44 083A BE5F 3827 \

SIGN2="004A FC90 AB47 3F6B 59BC 0E6D 6681 6971 A76A BA52 98E2

\

5671 26B3 0E78 791B 109F 0591 7DC3 F09F 4D8D 4FB7 E341 4A03 \

CD68 1D77 27F8 8555 9CF7 DEDD 9380"

INCREMENT SERIES_1 adskflex 1.000 permanent 100 \

VENDOR_STRING=commercial:permanent BORROW=4320 DUP_GROUP=UH \

SUITE_DUP_GROUP=UHV SN=123-12345678 SIGN="1707 9EAC CBCB \

692E 4A89 FC45 C009 E360 944A 14BA E99C 9B24 5A1B 4A44 BE5F \

3827 AA26 30CC 2AC2 D6B3 A61B AB5E 492E 3EBD 0B48 DA82" \

SIGN2="004A FC90 AB47 3F6B 59BC 0E6D 6681 6971 A76A BA52 \

5671 26B3 0E78 791B 109F 0591 7DC3 F09F 4D8D 4FB7 E341 4A03 \

CD68 1D77 27F8 8555 9CF7 DEDD 9380"
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Example of a Package License File for a Redundant Server
Here is an example of a completed license file for a redundant license server
model:

SERVER 1a34567c90d2 27005

SERVER 2a34567c90d2 27005

SERVER 3a34567c90d2 27005

USE_SERVER

VENDOR adskflex port=2080

PACKAGE 64300ACD_F adskflex 1.000 COMPONENTS="57600ACD_2009_0F \

   54600ACD_2008_0F 51200ACD_2007_0F 48800ACD_2006_0F" \

   OPTIONS=SUITE SUPERSEDE ISSUED=27-May-2008 SIGN="1092 05D8 \

   A206 276B 2C84 EFAD ACA5 C54B 68A4 653E C61F 31DE C8CE B532 \

   CFBB 0006 5388 347B FDD6 A3F4 B361 7FD4 CDE4 4AAC 0D11 B0EF \

4B44 BFD6 3426 97DD" SIGN2="0670 B01A D060 0069 FF25 F1CD D06B

\

314E E7C9 3552 5FFA 4AC7 28A7 C897 F56A 19BB FB1C 754E 6704 \

DEEA AC4E F859 2E9B 64B6 0DD0 9CCE 9556 269F EAC0 2326"

INCREMENT 64300ACD_F adskflex 1.000 permanent 50 \

VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=27-May-2008 \

SN=399-99999999 SIGN="1B5B 8D70 4CAD 32E5 9CA2 82E0 5C47 291C

\

35AB 9B9C 5B3E 5067 F61B 4139 1B32 0716 1FD3 5105 A991 B78E \

9D1E 63AB BC23 0D1E B70C 2A05 E1C1 F605 ABB1 2EA8" SIGN2="01D6

\

31F5 2951 4500 E5C8 058F 7490 9789 9EF4 CBED DA27 5F06 6780 \

9033 2018 0C3B E1E0 3580 E60E C2BB B4AB 8D6A 4245 3059 8CA6 \

2EFE DFAE 027F 2ABE 3F2B"
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Example of a Package License File for Combined Autodesk
Product Versions

Here is an example of a completed license file for combined Autodesk product
versions:
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SERVER servername 123456789111

USE_SERVER

VENDOR adskflex port=2080

PACKAGE 64300ACD_F adskflex 1.000 COMPONENTS="57600ACD_2009_0F \

   54600ACD_2008_0F 51200ACD_2007_0F 48800ACD_2006_0F" \

   OPTIONS=SUITE SUPERSEDE ISSUED=25-Jun-2008 SIGN="03EF DE18 \

   8046 0124 4EA4 6953 F82D 3169 7C24 D0DE E58E 8168 FFA3 D891 \

   B43B 08D8 7E7F C6ED CBCC FE2A BB0A 4566 C2AE F1C1 D373 8348 \

   E6E3 884A E398 1C78" SIGN2="07AC D696 8844 D19F AB00 8B75 53A3

\

   2F76 91DF AED0 3231 1506 0E6B ADC6 C3B8 1797 93B5 9756 8C0F \

   8811 56E6 B2BA 0523 FE2E 82B7 1628 076F 173B F37C 7240"

INCREMENT 64300ACD_F adskflex 1.000 permanent 2 \

   VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

   DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=25-Jun-2008 \

   SN=399-99999999 SIGN="1CCB E88D B819 8604 06FA 9AEE 42F1 CBEA

\

   37B9 3CFA A0A8 697F 9CB1 8354 6256 05ED 69D4 D2FF D512 6A2E \

   D5DD B722 EF5B 3172 BA95 4625 F8D3 DD24 BB39 6A58" SIGN2="0DFF

\

   FA6F C378 20E0 2622 BE52 B434 F99F 2681 2B93 64F2 CE0C 7F4A \

   7024 B3D1 051A 6920 72BD DE35 8920 E6A1 C8D6 AF23 7BE7 CC91 \

   6916 70B1 9E80 AB07 1644"

PACKAGE 64800INVPRO_F adskflex 1.000 \

COMPONENTS="59600INVPRO_2009_0F \

   55300INVPRO_2008_0F 51400INVPRO_11_0F 49000INVPRO_10_0F" \

   OPTIONS=SUITE SUPERSEDE ISSUED=25-Jun-2008 SIGN="1306 5990 \

   F8A1 56FB 1D8A 9DA7 D6AE 8E9E F6EC 2862 367A 36E2 C5FB E6E1 \

   4AAA 0128 8C2D 95FD 09B2 ABA1 6F98 A0A3 70DE 3220 6835 7E51 \

   3849 9D81 8BDC 9DC1" SIGN2="0021 AA08 F2E7 8AEB 5345 341A 7E42

\

   3001 B8C5 DFC2 6EB8 87C5 C04A AE43 A10F 1DA1 EF8A F0FA 10F5 \

   AC81 1E22 789F A18D 650F 6BBB 563A BDA5 DD1C 82EC 27F6"

INCREMENT 64800INVPRO_F adskflex 1.000 permanent 2 \

   VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \

   DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=25-Jun-2008 \

   SN=399-99999966 SIGN="0BE4 51F4 570C DC48 5E66 F952 629E EDF0

\

   019C 6FF7 0509 1FF0 D4FB 3B16 1981 073F 31EC A241 8CB3 8782 \

   E655 00C6 E097 D5EF B0D8 67D3 199D 699D 2E09 B16F" SIGN2="1254

\

   3E37 0CE4 F42D B7CD 858C 92FC A963 5274 770F 9354 FE29 E117 \

   205D C632 0C4E AEC0 7501 9D9E FFEB D84D F154 16A1 E120 339A \
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License Types and Behaviors
Autodesk supports dynamic product usage and license behaviors. This means
that you can purchase a specific type of behavior with a specific license and
change that license at a later date without having to uninstall and reinstall
the Autodesk product.

NOTE All license types are available as stand-alone and network except for the
Student Portfolio license, which is available as stand-alone only.

License types include the following:

■ Commercial. A license for a product that was purchased commercially.

■ Not for Resale. A license for a product that is not sold commercially. Not
for Resale products are for evaluation or demonstration purposes only and
may not be used for commercial or production use.

■ Educational (EDU)/Institution. A license designed specifically for
educational institutions.

■ Student Portfolio. A license for students who are using an Autodesk product
as part of their curriculum.

License behaviors are as follows:

■ Permanent. Enables permanent use of an Autodesk product.

■ Term Extendable. Enables access to an Autodesk product for a limited time.
The term can be extended at any time.

■ Term Non-Extendable. Enables an Autodesk product for a limited time.
The term cannot be extended.

Heartbeat Signal
When an Autodesk product is running, it communicates with the license
server at regular intervals using a communication method known as the
“heartbeat” signal. If the heartbeat signal is lost, the server tries to reconnect.
If the server cannot reconnect, the user receives a license error.
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If the product stops working because it has lost a connection to the server,
you must shut down the product, and then restart it. If the problem causing
the original loss of the heartbeat signal is resolved and there are available
licenses on the server, the program can be restarted.

Network License Manager
The Network License Manager is used to configure and manage the license
servers. When creating a deployment, the Installation wizard prompts you
for information about the license manager, such as license server model and
server name.

For more information about deploying an Autodesk product from a network
location, see your product’s installation documentation.

Install the Network License Manager
The Network License Manager is used to configure and manage license servers.
It includes the lmgrd, adskflex, and lmutil tools that you need to set up your
license server.

You can install the Network License Manager before or after you use the
Installation wizard. The order in which you install the network applications
does not matter, as long as you install everything you need and you provide
consistent license server information across the network applications.

If an earlier version of the Network License Manager is already installed on
the computer, you should upgrade by installing the Autodesk Network License
Manager into the folder where the older version was located.

To install your Network License Manager:

1 In the Autodesk Installation wizard, click Install Tools and Utilities.

2 On the Select the Products to Install page, select Autodesk Network License
Manager and click Next.

3 Review the Autodesk software license agreement for your country or
region. You must accept this agreement to proceed with the installation.
Choose your country or region, click I Accept, and then click Next.

NOTE If you do not agree to the terms of the license and want to terminate
the installation, click Cancel.
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4 On the Begin Installation page, review your product selection and the
current settings. If you do not want to change anything, click Install. If
you want to change the install type or installation path, click Configure.

5 On the Select the Installation Location page, accept the default installation
path (C:\Program Files\Autodesk Network License Manager) or Browse to
specify a different path. If you enter a path that does not exist, a new
folder is created using the name and location you provide. Click Next.

WARNING Do not install the Network License Manager on a remote drive.
When you install the Network License Manager files, you must provide a path
to a local drive. You must specify the drive letter; the universal naming
convention (UNC) is not permitted.

6 On the Configuration Complete page, click Configuration Complete to
return to the confirmation page.

7 On the Begin Installation page, click Install.

8 When the Installation Complete page displays, click Finish.

Patch the License Manager on an IPv6 Network
If you are using a license server on an IPv6 (Internet Protocol version 6)
network, you must install a patch to the Autodesk Network License Manager,
otherwise the license server will not work.

To install the patch:

1 Shut down your license server.

2 Back up the contents of the license manager files. By default, these are
in C:\Program Files\Autodesk Network License Manager.

3 Download the patch from http://www.autodesk.com/nlm2011-ipv6-windows.

4 Unzip the patch and paste the new files over the old ones; these are
located by default in C:\Program Files\Autodesk Network License Manager.
(Four files will be overwritten.)

5 Restart your license server.
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Obtain a License Through autodesk.com
You can register and activate your network license by going to
https://registeronce.autodesk.com and following the on-screen instructions.

Obtain the Server Host Name and Host ID Manually
Autodesk uses the server host name, host ID, and product serial number to
generate a license file.

To obtain the information manually, you can use the command prompt or
you can run the lmtools.exe utility. If you use lmtools.exe, do not run it on a
remote workstation.

To obtain the host name and ID using the Windows command prompt:

1 Do one of the following:

■ (Windows XP) Click Start > Programs > Accessories > Command
Prompt.

■ (Windows Vista) Click Start > All Programs > Accessories > Command
Prompt.

2 In the Windows command prompt, enter the following command, then
press Enter:

ipconfig /all

3 Locate the Host Name line, and write down the host name.

4 Locate the Physical Address line. Write down the physical address without
the dashes. This is your twelve-character host ID.

NOTE If your server has more than one network adapter, select the one that
corresponds to a physical network adapter. To determine which adapters are
physical: in the Windows command prompt, enter ipconfig /all, and then
view the Description field above each physical address. If there is more than
one physical network adapter, it does not matter which one you use. Devices
such as VPN adapters, PPP adapters, and modems are not valid.

5 Close the Windows command prompt.
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To obtain the host name and ID using lmtools.exe:

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS program, click the Systems Settings tab.

3 On the Systems Settings tab, locate the Computer/Hostname box. Copy
the host name and paste the information into a text editor.

4 Locate the Ethernet Address box. The Ethernet address is the host ID. It
consists of twelve characters. Write down the information. If your Ethernet
address is more than twelve characters, write down the first twelve
characters only.

NOTE If your server has more than one Ethernet adapter, select one that
corresponds to a physical network adapter.

5 Close lmtools.exe.

Configure a License Server
You configure a license server so that you can manage your Autodesk product
licenses. Configure the license server with the lmtools.exe utility.

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

To configure your license server:

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS program, on the Service/License File tab, make sure the
Configure Using Services option is active.

3 Click the Config Services tab.

4 In the Service Name list, select the service name you want to use to
manage licenses.

By default, the service name is Flexlm Service 1. If FLEXnet® is managing
other software on your computer in addition to Autodesk, you can change
the service name to avoid confusion. For example, you can rename Flexlm
Service 1 to Autodesk Server1.
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NOTE If you have more than one software vendor using FLEXnet for license
management, the Service Name list contains more than one option. Make
sure that only one Autodesk service is listed.

5 In the Path to Lmgrd.exe File field, enter the path to the Network License
Manager daemon (lmgrd.exe), or click Browse to locate the file.

By default, this daemon is installed in the C:\Program Files\Autodesk
Network License Manager folder.

6 In the Path to the License File box, enter the path to your license file, or
click Browse to locate the file.

This is the path to the license file obtained through autodesk.com or the
location where you placed the license file if you obtained it offline.

7 In the Path to the Debug Log File box, enter a path to create a debug log,
or click Browse to locate an existing log file.

It is recommended that you save to the C:\Program Files\Autodesk Network
License Manager folder. The log file must have a .log file extension. For
new log files, you must enter the .log extension manually.

8 To run lmgrd.exe as a service, select Use Services.

9 To start lmgrd.exe automatically when the system starts, select Start Server
at Power Up.

10 Click Save Service to save the new configuration under the service name
you selected in step 4. Click Yes when prompted if you would like to save
the settings to the service.

11 Click the Start/Stop/Reread tab and do one of the following:

■ If a service has not yet been defined for Autodesk, click Start Server
to start the license server.

■ If a service for Autodesk is already defined and running, click ReRead
License File to refresh the Network License Manager with any changes
made to the license file or Options file.

The license server starts running and is ready to respond to client requests.

12 Close lmtools.exe.

NOTE Before performing any system maintenance on your license server,
see Stop and Restart the License Server.
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Uninstall the Network License Manager
You can uninstall the Network License Manager from the license server. When
you uninstall the Network License Manager, licenses are no longer available
to your users.

NOTE You must manually delete files that you created for use with the Network
License Manager (such as log files, license files, and the Options file). They are not
automatically deleted when you uninstall.

To uninstall the Network License Manager

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS program, click the Start/Stop/Reread tab.

3 On the Start/Stop/Reread tab, click Stop Server.

4 Close lmtools.exe.

5 In the Windows Control Panel, do one of the following:

■ (Windows XP) Double-click Add/Remove Programs.

■ (Windows 7/Windows Vista) Double-click Programs and Features.

Do one of the following:

■ (Windows XP) In the Add/Remove Programs window, click Autodesk
Network License Manager. Click Remove.

■ (Windows 7/Windows Vista) In the Programs and Features window,
click Autodesk Network License Manager. Click Remove.

6 If prompted, restart your computer.

Network Licensing Tools
Autodesk Network licensing tools include FLEXnet configuration tools, license
borrowing, and SAMreport-Lite. Each tool is described in the sections that
follow.

NOTE MotionBuilder does not support SAMreport-Lite.
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This section also includes information for updating FLEXnet and installing
and configuring the Autodesk Network License Manager on a network.

FLEXnet Configuration Tools
The Network License Manager uses FLEXnet® license management technology
from Acresso Software. FLEXnet provides administrative tools that help to
simplify management of network licenses. You can use FLEXnet tools to
monitor network license status, reset licenses lost to a system failure,
troubleshoot license servers, and update existing license files on the fly.

For information about using FLEXnet configuration tools, you can find the
LicenseAdministration.pdf document in the following directory: C:\Program
Files\Autodesk Network License Manager\Docs\FlexUser\LicenseAdministration.pdf.

Utilities for License Server Management
FLEXnet provides two utilities for managing the license server. These tools
are located in the C:\Program Files\Autodesk Network License Manager folder.

lmtools.exe Provides a Microsoft® Windows graphical user interface for
managing the license server.

lmutil.exe Provides a set of command line options for managing the license
server.

You can use lmtools.exe or lmutil.exe to perform the following server
management tasks:

■ Start, stop, and restart the server.

■ Configure, update, and reread the license file.

■ Diagnose system or license problems.

■ View server status, including active license status.

Stop and Restart the License Server
Before you can perform any system maintenance on your license server, you
must stop the license server. When you have completed maintenance, you
can restart the license server.
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To stop the license server (Windows)

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS program, on the Service/License File tab, select the
Configure Using Services option.

3 Select the service name for the license server you want to stop manually.

4 Click the Start/Stop/Reread tab.

5 On the Start/Stop/Reread tab, click Stop Server.

6 Close lmtools.exe.

To restart the license server (Windows)

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In the LMTOOLS program, on the Service/License File tab, select the
Configure Using Services option.

3 Select the service name for the license server you want to start manually.

4 Click the Start/Stop/Reread tab.

5 On the Start/Stop/Reread tab, click Start Server to restart the license server.

Update FLEXnet from a Previous Version
This release of Autodesk products and later require FLEXnet version 11.7.0.0
or later. If you are currently using a version of FLEXnet that is earlier than
11.7.0.0, you need to upgrade to version 11.7.0.0 or later.

NOTE If the server where you plan to install the Autodesk Network License
Manager has FLEXnet installed for another product, make sure that the version of
lmgrd.exe is the most current version.
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To determine what version of FLEXnet is installed, you need to verify the
version of the following files:

Windows

■ lmgrd.exe

■ lmtools.exe

■ lmutil.exe

■ adskflex.exe

To verify the version of lmutil.exe, lmtools.exe, or adskflex.exe (Windows)

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

2 In lmtools.exe, click the Utilities tab.

3 On the Utilities tab, enter the location of the file, or click the Browse
button to locate the file and click Open. The file location should look
something like this:

C:\Program Files\Autodesk Network License Manager\lmutil.exe

4 On the Utilities tab, click Find Version.

The version number of the file you selected is displayed. If necessary, use
the following procedure to update your version of FLEXnet.

To update FLEXnet (Windows)

You should be logged in with Administrator rights when working with the
LMTOOLS utility.

1 Back up your license files.

2 Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network License Manager
 ➤  LMTOOLS Utility.

3 In the LMTOOLS program, click the Start/Stop/Reread tab.

4 On the Start/Stop/Reread tab, click Stop Server.

5 Close lmtools.exe.
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6 Note the location where the Network License Manager is installed and
then uninstall the Network License Manager. For details about uninstalling
the Network License Manager, see Uninstall the Network License Manager.

7 Install the Network License Manager. For details about installing the
Network License Manager to the same location as the previous version,
see Install the Network License Manager.

8 Do one of the following:

■ (Windows XP) Click Start  ➤  Programs  ➤  Autodesk  ➤  Network
License Manager  ➤  LMTOOLS.

■ (Windows Vista) Double-click the LMTOOLS icon on the desktop.

9 In the LMTOOLS program, click the Start/Stop/Reread tab.

10 On the Start/Stop/Reread tab, click Start Server.

11 Close lmtools.exe.

Set Up and Use an Options File
With an Options file, you set configuration options for managing licenses on
each license server that you set up. An Options file sets parameters that the
license file reads and the lmgrd program executes.

If you want to have the same license behavior on some or all of your license
servers, you must save the same Options file to each of those license servers.
If you want to specify different license behavior on different license servers,
you must create an Options file for each license behavior. You must save each
Options file to the server where you want specific license behavior.

NOTE For Options file changes to take effect on a license server, you must save
the Options file, and then use lmtools.exe to reread the license file.

Use the Options file to set parameters for the following server-related features:

Report log file A compressed, encrypted file is created that generates accurate
usage reports on license activity for use by SAMreport-Lite. See Create a Report
Log on page 62.

License borrowing If your Autodesk product supports the license borrowing
feature, you can allow users to borrow an Autodesk product license from a
network license server so that they can use the product without being
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connected to the license server. A license can be borrowed for a limited time.
See Configure License Borrowing with the Options File on page 63.

License timeout With license timeout, you can set a timeout period on your
license server for one Autodesk product at a time. When set, license timeout
returns a license to the license server when a connection with the workstation
is lost, or if a license is checked out but the Autodesk product is idle on a
workstation for longer than the timeout period you define. See Set Up License
Timeout on page 64.

License timeoutall With license timeoutall, you can set a timeout period on
your license server that applies to all Autodesk products installed on your
computer. When set, license timeout returns a license to the license server
when a connection with the workstation is lost, or if a license is checked out
but the Autodesk product is idle on a workstation for longer than the timeout
period you define. See Set Up License Timeout on page 64.

Here is an example of the contents of an Options file:

REPORTLOG=c:\test\report.rl

BORROW_LOWWATER Autodesk_f1 3

TIMEOUT Autodesk_f1 7200

You can also set up advanced license parameters, such as reserving a license,
restricting license usage, or defining groups of users. To learn more about
setting advanced Options file parameters, see the FLEXnet documentation in
the C:\Program Files\Autodesk Network License Manager\LicenseAdministration.pdf
file.

Create an Options file
You should be logged in with Administrator rights when working with the
LMTOOLS utility.

To create an options file

1 Open a text editor, enter the parameters you want, and then save the
document as a file named adskflex.opt to the same location where you
saved the license file.

NOTE Make sure you save the file with the extension .opt. The default
extension .txt is not recognized by the Network License Manager.
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2 Do one of the following:

■ (Windows) Click Start  ➤  All Programs  ➤  Autodesk  ➤  Network
License Manager  ➤  LMTOOLS Utility.

■ (Mac OS X) Launch a Terminal window, navigate to the Autodesk
Network License Manager folder, and enter the following:
./lmutil lmreread -c @hostname-all

Close the Terminal window.

3 In the LMTOOLS program, on the Start/Stop/Reread tab.

4 On the Start/Stop/Reread tab, click ReRead License File.

5 Close lmtools.exe.

Create a Report Log
In the Options file, you can create a report log file that is used with
SAMreport-Lite.

To create a report log

1 In a text editor, open the Options file, adskflex.opt.

2 In the Options file, enter the following syntax on its own line (with
REPORTLOG entered in uppercase, as shown):

REPORTLOG [+]report_log_path

For example (Windows), the syntax REPORTLOG +"c:\My
Documents\report.rl" means that a report log named report.rl is located
in the folder c:\My Documents.

For example (Mac OS X or Linux), the syntax REPORTLOG +"/Users/<user
id>/NLM/report.rl" means that a report log named report.rl is located in
the folder /Users/<user id>/NLM.

NOTE Path names that contain spaces must be enclosed in quotation marks.

In the REPORTLOG syntax, “[+]” means that entries to the log file you
create are appended rather than replaced each time the Network License
Manager is restarted. (It is recommended that you use this option so that
you retain a history of log entries.)
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Configure License Borrowing with the Options File
If your Autodesk product supports the license borrowing feature, you can use
the Options file to configure license borrowing options. For example, you can
define the maximum number of licenses that cannot be borrowed from your
network at any one time. In addition, you can define which users can borrow
an Autodesk product license. Licenses are borrowed per user, not per machine.

NOTE If your Autodesk product supports license borrowing, and licenses are
borrowed from a redundant license server pool, you must restart the license server
after you stop the Network License Manager.

At the end of a borrow period, the borrowed license is automatically disabled
on the user's computer and becomes available again on the license server.
Users can also return a license before a borrow period has ended.

To set license borrowing parameters

1 In the Options file, enter the following syntax on its own line (with
BORROW_LOWWATER entered in uppercase, as shown):

BORROW_LOWWATER feature_code n

In the BORROW syntax, “feature_code” is the name of the product in
the license file, and “n” is the number of licenses that cannot be borrowed.

For example, the syntax BORROW_LOWWATER Autodesk_f1 3 means
that for the product Autodesk_f1, three licenses cannot be borrowed from
the license server.

2 Enter the following syntax on the next line (with MAX_BORROW_HOURS
entered in uppercase, as shown):

MAX_BORROW_HOURS feature_code n

In this syntax, “n” is the number of hours that a license can be borrowed.

For example, the syntax MAX_BORROW_HOURS Autodesk_f1 360 means
that for product Autodesk_f1, licenses can be borrowed for 360 hours, or
15 days.

NOTE Licenses are borrowed in increments of 24 hours only. Any number
that is more than a 24-hour increment is not used. For example, the number
365 would be rounded down to 360 hours, or 15 days.
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For more information about setting up the license borrowing feature, see the
FLEXnet documentation in the C:\Program Files\Autodesk Network License
Manager folder.

NOTE To borrow a license in an Autodesk product, click Help menu  ➤  About
 ➤  Product Information. Alternatively, enter borrowlicense on the product
command line. Help for this feature is available in the Borrow a License for [Autodesk
Product] window and in C:\Program Files\[Autodesk Product]\Help\adsk_brw.chm.

Set Up License Timeout
License timeout is set in the Options file to determine how long a product
session can be idle before the license is reclaimed by the license server. When
you set this flag in the Options file, a user's license is reclaimed by the license
server if the product is idle on a workstation for more than the timeout period
you define.

If a user's license is lost because of the idle timeout, the product attempts to
claim a new license once the user uses the product again. If no license is
available, the user can save work before the product shuts down.

You can set individual license timeouts for each Autodesk product on your
computer by using the TIMEOUT parameter or you can set one license timeout
for all Autodesk products on your computer by using the TIMEOUTALL
parameter.

To set license timeout parameters

■ For individual Autodesk products: In the Options file, enter the following
syntax on its own line (with TIMEOUT entered in uppercase, as shown):
TIMEOUT feature_code n

In the TIMEOUT syntax, “feature_code” is the name of the product (referred
to in the INCREMENT line in the license file), and “n” is the number of
seconds before an inactive license is reclaimed by the license server.

For example, the syntax TIMEOUT Autodesk_f1 7200 means that for the
product Autodesk_f1, the license timeout period is set for 7200 seconds,
or two hours.

■ For all Autodesk products: In the Options file, enter the following syntax
on its own line (with TIMEOUTALL entered in uppercase, as shown):
TIMEOUTALL n
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In the TIMEOUTALL syntax, “n” is the number of seconds before an
inactive license is reclaimed by the license server.

For example, the syntax TIMEOUTALL 7200 means that for all Autodesk
products, the license timeout period is set for 7200 seconds, or two hours.

For more information about using the license timeout feature, see the FLEXnet
documentation in the C:\Program Files\Autodesk Network License Manager
folder.

License Borrowing
If you are running a network-licensed version of the program, you can borrow
a license from a license server to use the program for a specified time when
your computer is not connected to the network.

NOTE If you have a stand-alone version of the program, you cannot borrow a
license. To check your license type, click Help menu  ➤  About  ➤  Product
Information. In the Product Information dialog box, view your product license
type.

Overview
If you are using a network-licensed version of your Autodesk product and your
network administrator supports the license borrowing feature, you can borrow
a product license from your network license server to use the program when
your computer is not connected to the network. Your license is automatically
returned to the license server at the end of the day on the return date you set
when you borrowed the license. You can also return a license early.

NOTE There is a limit to the number of licenses available for borrowing. If you try
to borrow a license and are notified that no licenses are available, all network
licenses may already be borrowed by other users. If you are unable to borrow a
license, see your network administrator for help.

Borrow a License
You can run the program when your computer is not connected to the network
until your license-borrowing period ends. If you don't remember the date that
a license expires, you can check the date by placing your cursor over the

License Borrowing | 65



Borrowing icon in the program's status tray or by clicking Help  ➤  About and
using the Product Information dialog box.

When the license-borrowing period expires, the borrowed license is
automatically returned to the license server. Once your computer is
reconnected to the network, you can run the program from the network or
borrow a license again.

Interaction with Other License-Borrowing Tools

Using the license borrowing feature in the program is the recommended way
to borrow a license; however, some third-party borrowing tools may also be
available to you. These tools are not supported or compatible with the license
borrowing feature in the program. Other third-party or legacy
license-borrowing tools that may be available to you are the Autodesk License
Borrowing utility (shipped with Autodesk products) and the borrowing feature
in lmtools.exe, a component of the Autodesk Network License Manager.

If another license-borrowing tool is active when you attempt to use the license
borrowing feature, you should proceed as follows to borrow a license for the
program:

■ If you run the Autodesk License Borrowing utility that shipped with your
Autodesk product and then turn on the borrowing flag for the Adskflex
option or the All option, a license can be borrowed when you start the
program. However, you cannot return a license until you exit and then
restart the program.

■ If borrowing is set in lmtools.exe for all products, you can either (a) use the
other tool to borrow licenses for the program or (b) stop the borrowing
process in lmtools.exe and then use the license borrowing feature in the
program.

■ If borrowing is set in lmtools.exe for non-Autodesk products only, you must
stop the borrowing process in lmtools.exe. You can then use the license
borrowing feature to borrow licenses for your Autodesk product. If you do
not stop the borrowing process in lmtools.exe, the license borrowing feature
will not function.

To borrow a license using the Tools menu

1 Click Tools menu  ➤  License Borrowing  ➤  Borrow License.

2 In the Borrow a License window, on the calendar, click the date when
you want to return the license.
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This date must be within the valid date range set by your network
administrator. The valid date range is displayed in this window.

3 Click Borrow License.

4 In the License Borrowed message, click OK. The license is borrowed, and
you can now use the program while your computer is disconnected from
the network.

NOTE You can verify that your license is borrowed by placing your cursor
over the Borrowing icon in the status tray, which is in the lower-right corner
of the program.

Borrow a License Window

Tools menu: License Borrowing  ➤  Borrow License

Command line: borrowlicense

Using the license borrowing feature, you can borrow a license from your
network license server, and then use the license when your computer is
disconnected from the license server; for example, when you are traveling for
work.

The Borrow a License window has the following options:

Calendar Sets the date when you plan to return a borrowed license. The return
date must be within the range specified by your network administrator.

Borrow a License Borrows the license from the network license server based
on the return date that you specified.

Cancel Cancels the borrowing action; no license is borrowed.

Return a License
Your network license is automatically returned to the network license server
on the day that the license expires. You can also return a license earlier than
the date you originally selected, as long as your computer is connected to the
network license server when you attempt to return the borrowed license.

Once a borrowed license is returned, you can borrow a license again as long
as your computer is connected to the network license server and a license is
available on the server.
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To return a borrowed license early, do one of the following:

■ Click Tools menu  ➤  License Borrowing  ➤  Return License Early.

■ In the status tray, right-click the License Borrowing icon. Click Return
License Early.

NOTE To use the status tray to return a borrowed license early, the display settings
for the status tray must be turned on. To turn on the display settings, right-click
an empty area on the status bar. Click Tray Settings.

Your license is returned to the network license server. After you return the
borrowed license, you can borrow a license again immediately as long as a
license for that product is available on the network.

To check the license return date:

■ In the status tray, right-click the License Borrowing icon. View the
expiration date for the borrowed license.

Network Licensing FAQs
This section outlines some common questions and their solutions with regards
to software licenses and licensing your product(s).

What is the difference between a stand-alone license and a
network license?

Stand-alone licensed products are registered and activated to an individual
workstation. While the software can be installed on multiple systems in your
facility, the license only allows one system to be operational. If you need to
run more systems, you need to purchase more stand-alone licensed products,
or consider converting to multi-seat stand-alone licenses.

You cannot purchase a network licensed version of an Autodesk product.
However, a multi-seat stand-alone licensed version is available that does not
rely upon servers to maintain licenses. Multi-seat stand-alone licensing means
that each installation of your product uses a single serial number for
registration and activation.
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What is the benefit of using a network licensed version of the
software?

Since a network license option is not available for Autodesk products, a
multi-seat stand-alone license is recommended for large drafting/design
facilities, classrooms, and lab environments. Unlike a network licensed product,
you can install multi-seat stand-alone products on the maximum number of
systems that the license allows. For example, you purchase a multi-seat
stand-alone license for 25 seats and have 30 systems at your facility that can
communicate over the Internet. Even though you can install software on all
30 systems, only the first 25 systems you start will have their licenses activated.
Because the licenses are tied to each specific system, the remaining five systems
will never be able to run the software unless you purchase an additional five
licenses.

As long as all the systems have Internet access, products are automatically
activated the first time they are launched.

How do I change the license server information I entered during
the installation?

To change the license server information you entered

■

To change the license server information you entered

1 Navigate to the C:\Program Files\Autodesk\MotionBuilder 2011 directory
to locate and open the LICPATH.LIC file.

2 Edit the line SERVER <servername> where <servername> is your license
server name.

If you do not find the LICPATH.LIC file in this location, you can create a
license file by saving a text file with the extension .lic, and including the
following lines:

SERVER <servername> 0

USE_SERVER
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What is Internet Explorer used for?
After installing your product, you can operate in trial mode for a given number
of days. Whenever you launch the program, you are prompted to activate the
software. When you choose to activate the software, Internet Explorer makes
this process much faster. Once you entered your registration data and submit
it to Autodesk, an activation code is returned and you are not prompted again
during startup.

Where can I find more information on troubleshooting network
licensing?

If you experience difficulty with installation or licensing, visit
http://autodesk.com/servicesandsupport for additional FAQ information, as well
as an in-depth Knowledge Base that you can search for solutions to common
installation and licensing issues and error messages.
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Glossary of Licensing
Terms

The Glossary describes terms specific to the licensing of Autodesk software products.

The Glossary also includes acronyms used in the licensing process of Autodesk software
products.

Acronyms
The following is a list of acronyms used in the licensing process of Autodesk
software products.

IPv6
Internet Protocol version 6

JRE (Java Runtime Environment)
A program that is required to run Java programs. This program must be installed
with SAMreport-Lite.

Terms
The following is a list and description of terms specific to the licensing process
of Autodesk software products.
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ADSKFLEX_LICENSE_FILE
In a distributed license server configuration, the environment variable used
to point a workstation to the distributed license servers.

adskflex.exe
The Autodesk vendor daemon used with the FLEXnet license technology. This
daemon keeps track of the Autodesk licenses that are checked out and the
workstations that are using the licenses.

borrowed license
A license that allows you to use an Autodesk product for a limited period of
time without having to buy a separate license or have network access to the
license server.

daemon
A program that runs continuously in the background of a computer. The
daemon handles requests from the computer and then forwards the requests
to other programs or processes. The Network License Manager uses two
daemons: the vendor daemon (adskflex.exe) and the license manager daemon
(lmgrd.exe).

debug log file
A file used with FLEXnet to log connection activity (such as license failure or
starting and stopping) between the Network License Manager and the
workstation.

distributed server
A license server configuration option in which several servers are used to
manage license distribution. Each distributed license server has a unique
license file and a fixed number of licenses. If one distributed license server
fails, the other servers are still able to distribute their licenses.
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Ethernet address
See host ID on page 73.

feature code
A license file parameter that represents the product that is supported by that
license file.

FLEXnet
The Acresso Software license management technology implemented in the
Autodesk family of products.

heartbeat signal
The communication signal between the Network License Manager and the
workstation to verify that the workstation is accessible and has an active
Autodesk product session running.

host ID
The unique hardware address of a network adapter. Also known as Ethernet
address or physical address.

host name
The TCP/IP name associated with a computer. FLEXnet technology uses the
host name as a parameter; the host name must be distinguished from the
NetBIOS (server) name.

idle
A state of inactivity in your product that prompts a network license server to
reclaim a license. Inactivity is due to no mouse or keyboard activity and no
commands, LISP expressions, menu macros, or scripts in progress for the
period of time that is defined in the Options file. See also license timeout.
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license file
A file used with FLEXnet that controls the number of available seats. This file
must be in ASCII plain text format.

license server
A server that contains the Network License Manager.

license timeout
A feature that allows you to set up a timeout period on your license server to
automatically return an idle license to the server so that it is available for use
again.

licpath.lic
In both single and redundant server configurations, the file used to point the
workstation to the FLEXnet license server. Licpath.lic is located in the root
installation folder.

lmgrd.exe
The license manager daemon. This daemon handles the original contact with
the program, and then passes the connection to the vendor daemon,
adskflex.exe.

lmtools.exe
A graphical user interface utility used to administer the FLEXnet license
technology. (Lmutil.exe is the command line version of this utility.)

lmutil.exe
A command line utility used to administer the FLEXnet license technology.
(Lmtools.exe is the graphical user interface version of this utility.)
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master daemon
See lmgrd.exe on page 74.

network license
A license that allows you to run an Autodesk product with a license that is
shared by various computers on a network.

network license installation
A type of installation that requires you to install and run the Network License
Manager from a network server. You must install and configure the Network
License Manager before clients can run the Autodesk product.

Network License Manager
The technology used by Autodesk for network license management.

Options file
The file used by FLEXnet to control license manager parameters, such as
reserving licenses and creating report logs used with SAMreport-Lite.

physical address
See host ID on page 73.

redundant server
A license server configuration option in which three servers are used to
administer licenses. The redundant servers share a license file and a pool of
licenses. The redundant server pool remains functional as long as two of the
three servers are running and communicating with each other.
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report log file
A file used with FLEXnet and SAMreport-Lite. This log file provides information
about network license usage. The Options file creates the report log.

single server
The Network License Manager is installed on a single server, so
licensemanagement and activity is restricted to this server.

stand-alone license
A license that allows you to run an Autodesk product on a single workstation.

vendor daemon
See adskflex.exe on page 72.

workstation
A desktop computer used by an individual user on a network.
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